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Author Questionnaire
1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  NO  

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Yes
We will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k

Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible : https://review.jove.com/account/file-uploader?src=20721443 

3. Filming location: Will the filming need to take place in multiple locations?   Yes
If Yes, how far apart are the locations? 15KM


Current Protocol Length
Number of Steps:  25
Number of Shots:  56 (27 SC)

Introduction
Videographer: Obtain headshots for all authors available at the filming location. 

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Shukun Chen: We study podocyte injury and potential treatment strategies for Diabetic Kidney Disease using Chinese traditional medicines. 
1.1.1. [bookmark: _Hlk194676695]INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B-roll: 2.3.1  

What are the most recent developments in your field of research?
1.2. Shukun Chen: Network pharmacology and multi-omics integration are enabling deeper insights into traditional Chinese medicine mechanisms, especially for chronic diseases like diabetic kidney disease.
1.2.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B-roll:3.2.1
What are the current experimental challenges?
1.3. Yan He: Validating complex multi-target predictions from network pharmacology in vivo and isolating individual active compounds from multi-herb formulations remain significant challenges.
1.3.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B-roll: 4.3.1

What research questions will your laboratory focus on in the future?
1.4. Sichao Ma: We will investigate YHT’s effects on lipid metabolism, caspase signaling, and explore personalized TCM strategies using network pharmacology.
1.4.1. INTERVIEW: Named talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B-roll: 5.1.3


Videographer: Obtain headshots for all authors available at the filming location.

Ethics Title Card
This research has been approved by the Ethics Committee at the Changchun University of Traditional Chinese Medicine



Protocol  
2. Urine and Blood Retrieval from Drug-Treated Mice
Demonstrator: Click here to enter name of demonstrator(s) 

Authors, please provide the demonstrator’s name after the shoot
2.1. To begin, use the non-dominant hand to firmly grasp the back of the mouse, aligning the head, neck, and body in a straight line [1]. Position a 1 milliliter gavage needle at an angle that matches the physiological curvature of the mouse’s esophagus [2]. Insert the needle through the corner of the mouse's mouth [3], press it down onto the tongue, slide it along the palate, and gently advance it into the stomach to administer the drug [4].
2.1.1. WIDE: Talent gripping the mouse securely with the non-dominant hand.
2.1.2. Close-up of the gavage needle being aligned with the esophageal angle.
2.1.3. Close-up of the needle entering through the mouth.
2.1.4. Shot of needle being advanced carefully into the stomach.

2.2. After 8 weeks of continuous drug administration, place each mouse in a metabolic cage to collect 24-hour urine [1]. Centrifuge the collected urine at 7,992 g for 10 minutes [2]. After carefully removing the supernatant, measure the urine protein level in it using the urinary protein test kit [3].	Comment by Poornima  G: Authors, is the drug administered everyday for 8 weeks?
Please answer this question
2.2.1. Talent placing a mouse in a metabolic cage.
2.2.2. Talent loading urine samples into the centrifuge.
2.2.3. Talent applying sample to a urinary protein test kit tube.

2.3. Then, using the non-dominant hand, grip the back of the mouse to secure it, and use the little finger and ring finger to hold the tail firmly [1]. Sterilize the tip of the tail with an iodine vapor cotton ball [2]. With the dominant hand, puncture the tip of the tail using a blood collection needle [3] and squeeze from the root to the tip of the tail to release a drop of blood onto a blood glucose test paper [4-TXT].
2.3.1. Talent holding the mouse and tail securely using the non-dominant hand.
2.3.2. Talent sterilizing the tail tip with iodine vapor.
2.3.3. Talent pricking the tail tip using a needle.
2.3.4. Talent squeezing the tail and dropping blood onto a glucose test paper. TXT: Inject phenobarbital sodium; Isolate blood after eyeball-removal 


2.4. Incubate the tube with blood at room temperature for 10 minutes [1] and then centrifuge it for 10 minutes at 7,992 g [2]. After the spin, extract the supernatant solution carefully [3].
2.4.1. Talent placing sample tube on the benchtop for incubation.
2.4.2. Talent loading tube into the centrifuge and initiating the spin.
2.4.3. Talent pipetting out the supernatant from the centrifuged tube into a fresh tube.



3. Western Blot (WB) Analysis of Treated Mouse Kidney Tissues
Demonstrator: Click here to enter name of demonstrator(s) 

3.1. After isolating renal tissues from the animal, place approximately 100 milligrams of frozen kidney tissue into a grinding vessel [1] and add 500 microliters of lysis solution containing protease and phosphatase inhibitors along with RIPA (ree-pa) buffer [2-TXT]. Grind the mixture thoroughly until no visible tissue mass remains [3].
3.1.1. WIDE: Talent adding frozen kidney tissue into a pre-labeled grinding vessel.
3.1.2. Talent pipetting lysis buffer mixture into the vessel. TXT: Protease inhibitor:Phosphatase inhibitor:RIPA=1:1:100 Video editor: This is a ratio
3.1.3. Talent using a pestle to grind tissue until homogenized completely.

3.2. Then, incubate the tube on ice for 30 minutes [1] and centrifuge it at 15,984 g for 10 minutes [2].
3.2.1. Talent placing tube on ice.
3.2.2. Talent placing tube into centrifuge and closing the lid.

3.3. After removing the supernatant, add 5× protein loading buffer to it [1]. Boil the sample at 100 degrees Celsius for 10 minutes [2], then remove and allow it to cool to room temperature [3].
3.3.1. Talent adding protein loading buffer into the sample tube.
3.3.2. Talent placing the tube in a dry bath at 100 degrees Celsius.
3.3.3. Talent removing the tube from the heat and letting it cool.

3.4. Separate the proteins using 12.5 percent SDS-PAGE gel electrophoresis [1]. Set the voltage to 80 volts to allow the sample to pass slowly through the concentration gel [2], then adjust to 120 volts until the sample reaches the bottom of the separation gel, and turn off the unit [3].
3.4.1. Talent loading the sample into SDS-PAGE wells.
3.4.2. Shot of electrophoresis unit running at 80 volts during stacking gel separation.
3.4.3. Talent changing the volts to 120 as the sample runs through concentration gel.

3.5. Now, transfer the proteins from the gel to activated PVDF membrane using a transfer apparatus [1] at a constant current of 200 milliamperes [2].
3.5.1. Talent assembling the membrane and gel stack with proper orientation.
3.5.2. Talent adjusting the current setting to 200 mA.

3.6. Next, incubate the PVDF membrane in blocking buffer, followed by primary and secondary antibodies [1].
3.6.1. TEXT ON PLAIN BACKGROUND: 
· Blocking buffer: 90 min, RT 
· Wash with TBST: 3 x 5 min
· Primary antibodies: Overnight, 4 ℃
WT-1 (1:1,000), CD2AP (1:1,000), P-PI3K (1:1,000), P-AKT (1:1,000), P-NF-κB (1:1,000), IL-1β (1:1,000)
· Wash with TBST: 3 x 5 min
· Secondary antibody (1:10000): RT, 60 min 
· Wash with TBST: 3 x 5 min



3.7. Add the ECL luminescent solution, mixed in a 1 to 1 ratio, dropwise and place the membrane in the chemiluminescence imager [1].
3.7.1. Talent applying ECL solution and inserting the membrane into the chemiluminescence imaging device.




4. Network Pharmacology Analysis of Yinhuo Tang (YHT) For Diabetic Kidney Disease (DKD) Treatment

Demonstrator: Click here to enter name of demonstrator(s) 

4.1. Identify the active ingredients of Radix Rehmanniae Praeparata, Morindae officinalis Radix, Poria, and Schisandra chinensis using the TCMSP database [1], and of Maitake using the BATMAN (bat-man)-TCM database [2]. Set oral bioavailability to be greater than or equal to 30 percent [3] and drug-likeness to be greater than or equal to 0.18 as the screening criteria [4].
4.1.1. SCREEN: Show the TCMSP website, entering the herb names and accessing the search results.
4.1.2. SCREEN: Show the BATMAN-TCM website, entering Maitake and accessing the search results.
4.1.3. SCREEN: setting OB ≥ 30% 
4.1.4. SCREEN: DL ≥ 0.18 in the database UI.

Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible : https://review.jove.com/account/file-uploader?src=20721443 

4.2. Use the TCMSP database to retrieve the targets of action corresponding to the active ingredients from the selected traditional Chinese medicines [1].
4.2.1. SCREEN: Display the targets listed under each compound after searching in TCMSP.

4.3. To standardize the target names, enter them into the UniProt protein database [1] and retrieve the official gene symbols [2].
4.3.1. SCREEN: Paste compound target names into UniProt search.
4.3.2. SCREEN: standardized names appearinf.

4.4. In the network analysis software, select File, Import and Network [1] and load the dataset to import the list of active ingredients and their corresponding targets [2].
4.4.1. SCREEN: Show the software interface and selection of File > Import > Network.
4.4.2. SCREEN: dataset being loaded and appearing.

4.5. To perform network topology analysis, use Tools, followed by Network Analysis and Analyze Network [1] to generate the network map [2].
4.5.1. SCREEN: User selects Tools > Network Analysis > Analyze Network in the software.
4.5.2. SCREEN: Show the generated netwrok.

4.6. Search for Diabetic Kidney Disease-related targets using the GeneCards, OMIM, TTD, DrugBank, and DisGeNET (dis-G-net) databases with species set to Human [1].
4.6.1. SCREEN: show searches on genecards database using “Diabetic Kidney Disease” and saving the results.

4.7. Merge the obtained targets from all five databases into a spreadsheet [1]. Go to under the Data menu and use the Remove Duplicates function to retain unique entries only [2].
4.7.1. SCREEN: Show data being merged in a single file.
4.7.2. SCREEN: Data > Remove Duplicates being applied.

4.8. In a spreadsheet, enter Yinhuo Tang or YHT targets in one column and diabetic kidney disease or DKD targets in another [1]. Use Conditional Formatting to highlight the common entries and identify intersection targets [2].
4.8.1. SCREEN: Excel interface with data entry for YHT and DKD targets.
4.8.2. SCREEN: Use of Conditional Formatting to highlight the common entries and identify intersection targets .

4.9. Now, open the STRING (spring) database and use Input followed by Paste/Upload (paste or upload) to import the intersection targets [1]. Then, set the threshold Degree to greater than or equal to 1 to exclude targets without interactions [2].
4.9.1. SCREEN: User pasting data into STRING input box and submitting the query.
4.9.2. SCREEN: Setting interaction threshold and displaying resulting network.

4.10. Import the filtered intersection targets into the software using File followed by Import and Network to visualize the protein interaction map [1].
4.10.1. SCREEN: clicking File followed by Import and Network to visualize the protein interaction map.

4.11. Then, navigate to Network Analysis and Analyze Network to extract core targets based on their Degree value [1].
4.11.1. SCREEN: Sorting the nodes based on Degree and filtering for core targets.

4.12. Visit the Metascape platform and click Start Analysis [1]. In the Custom Analysis section, paste the list of YHT-DKD intersection targets, select Homo sapiens, set the P-value threshold to less than 0.01, and click Submit [2].
4.12.1. SCREEN: Metascape platform and click Start Analysis .
4.12.2. SCREEN: Custom Analysis section, pasting the list of YHT-DKD intersection targets, selecting Homo sapiens, set the P-value threshold to less than 0.01, and click Submit.

4.13. Go to the bioinformatics visualization site, select Tools and Enrichment GO Term [1], paste the GO terms from Metascape, and submit to generate bubble charts [2]. Visualize the top 10 GO terms sorted by P-value [3].
4.13.1. SCREEN: In bioinformatics visualization site, select Tools and Enrichment GO Term.
4.13.2. SCREEN: paste the GO terms from Metascape, and submit
4.13.3. SCREEN: Bubble chart display showing top 10 terms.

4.14. Finally, sort the KEGG pathway enrichment results from Metascape based on P-value [1]. Go to the same site, select go KEGG pathway enrichment, paste the top 10 KEGG pathways, and click Submit to visualize them in bubble diagrams [2].
4.14.1. SCREEN: Interface showing the KEGG pathways and p-values.
4.14.2. SCREEN: Final KEGG bubble diagram output being generated with labeled pathways.




Results
5. Results 

5.1. The model group showed significantly elevated levels of random blood glucose [1], urine albumin [2], serum creatinine [3], and blood urea nitrogen [4] compared to the control group [5], all of which were markedly reduced following YHT treatment in a dose-dependent manner [6]. Similarly, the levels of aspartate aminotransferase, alanine aminotransferase, total cholesterol, and triglycerides were notably reduced in the YHT-treated groups, suggesting that the treatment promotes enhanced liver function and better metabolic control [7].
5.1.1. LAB MEDIA: Figure 1A. Video editor: Highlight the tallest bar in the MOD group for random blood glucose
5.1.2. LAB MEDIA: Figure 1B. Video editor: Highlight the highest bar in the MOD group for urine albumin
5.1.3. LAB MEDIA: Figure 1C. Video editor: Highlight the high bar in the MOD group for serum creatinine
5.1.4. LAB MEDIA: Figure 1D. Video editor: Highlight the tall BUN bar in the MOD group
5.1.5. LAB MEDIA: Figure 1A B C D   Video editor: Highlight the CON bars in A B C D  
5.1.6. LAB MEDIA: Figure 1A B C D   Video editor: Highlight the YH-L, YH-M, and YH-H Bars in A B C D
5.1.7. LAB MEDIA: Figure 1F G H I  Video editor: Highlight the YH-L, YH-M, and YH-H Bars in F G H I 

5.2. Serum albumin levels, which were reduced in the model group [1], showed significant recovery in all YHT-treated group [2].
5.2.1. LAB MEDIA: Figure 1E. Video editor: Highlight the lowest grey bar in MOD group
5.2.2. LAB MEDIA: Figure 1E. Video editor: Highlight the Bars YH-L, YH-M, and YH-H

5.3. Western blot analysis showed elevated protein levels of Phospho-PI3K, Phospho-AKT, Phospho-NF-κB (N-F-kappa-B), and IL-1beta in the model group [1], which were clearly reduced after YHT treatment [2]. The quantification graphs confirmed the same [3].
5.3.1. LAB MEDIA: Figure 5E. Video editor: Emphasize the bands in the MOD group column (for all rows P-PI3K, P-AKT, P-NF-κB, and IL-1β)
5.3.2. LAB MEDIA: Figure 5E. Video editor: Emphasize the bands in YH-L, YH-M, and YH-H lanes 
5.3.3. LAB MEDIA: Figure 5F G H and I. Video editor: Highlight the Bars YH-L, YH-M, and YH-H in F G H and I

5.4. Network pharmacology identified 84 overlapping targets between YHT and DKD, suggesting common intervention points [1].
5.4.1. LAB MEDIA: Figure 4B. Video editor: Focus on the yellow overlapping region in the Venn diagram labeled “84”

5.5. AKT1, IL-1beta, and other inflammation-related molecules were revealed as central nodes in the protein–protein interaction network, indicating their key roles in YHT’s action against DKD [1].
5.5.1. 5.5.1 LAB MEDIA: Figure 4C. Video editor: Highlight the centrally placed red and dark orange node labeled “AKT1” and “IL-1β” dot towards its left

5.6. Gene Ontology enrichment analysis showed significant involvement in hormone response and oxidative stress pathways [1], and KEGG (kegg) pathway analysis identified AGE-RAGE (age-rage) signaling as a top pathway [2].
5.6.1. LAB MEDIA: Figure 4D. Video editor: Highlight the first 4 green bars on the extreme left 
5.6.2. LAB MEDIA: Figure 4E. Video editor: Highlight the top red bubble labeled “AGE–RAGE signaling pathway in diabetic complications”

[bookmark: _Hlk203169093]NOTE to Authors: 
It's better if you upload each screen recording after naming each file according to the corresponding shot number (3-digit bullet, e.g, 2.2.1, 2.1.3, etc). 

But if you prefer to record all the steps together and upload a single screen capture file, that is okay.
In this case, you need to indicate the corresponding timestamp against each shot.
For example if the action described in shot 2.1.2 is present in the file name xxx.mp4 and is in between timestamp 00:30 to 00:45 then write as following in script above (shown in red font below). 
Example, shot 2.1.2 SCREEN: performing ........... action.   xxx.mp4 00:30-00:45.
                        2.2.2 SCREEN: clicking on.............button xxx.mp4 01:00-01:25

Please note that every shot (3-digit step) should have the best corresponding video clip of only 20 to 25 seconds and not more than that, so that the voice narration can match the duration.

If a particular shot takes minutes to complete, we can choose timestamps at the beginning and end of the process so that the total time is again within the 25-second limit.
Example: 3.1.1 SCREEN: Clicking on the 'analyze and plot' button, analysis in progress and the graph being plotted.  xxx.mp4 00:00-00:10 and 02:30-02:40
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